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Xilinx ISE and Spartan-3 Tutorial
for Xilinx ISE 7.1i the Digilent / Xilinx Spartan-3 Starter Board

Introduction

This tutorial will show you how to create a simple Xilinx ISE project based on the

Spartan-3 Board. We will be implementing a simple decoder circuit that uses the switches on the
board as inputs and the eight LEDs as outputs. There are several parts to this tutorial. Part 1
shows the basics of creating a project in Xilinx ISE. Part 2 shows how to create a PROM file that
can be written to the non-volatile memory on the Spartan-3 board (because the FPGA’s

configuration is lost when power is turned off). Part 3 shows how to then program the board.

Part 1: Starting a new Project

Fle Edt Yew Project Source Process Simulation Windom Help
D[=(=]g] 5| ERE BEEE E L2 slEE] ol ] = @l

Souces in Project |
[Mo Froject Oper]

" ™8 Module View [ 108 Srepshot .. | [0 Librar View

Select the Madules or Snapshot tab
[MNo Processes Avaiable]

" Bl Console [@@Find n Fies | 3€ Evors| 1 Warings |
Ready [ 4
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Select File > New Project.

Select a project location and name. For this tutorial we will name the project “decoder’:

MNew Project ﬂ

—Enter a Mame and Location for the Project

Project Mame: Project Location:
Idecaderl C:\ecebyd\decoder |

— Select the type of Top-Level module for the Project

Top-Level Module Type:

HDL |

¢ Back et » Cancel Help

Click Next.
Select the device family, device, package, and speed grade, as shown here:

MNew Project ﬂ

— Select the Device and Dezign Flow for the Project
Property Hame Yalue
Device Family -
Device weedz 200
Package ft256
Speed Grade -4
Top-Level Module Type HOL
Synthesziz Tool =5T MMHDL A erilog)
Simwilator b odelsim
Generated Simulation Language WHOL

¢ Back I et » I Cancel Help

Click Next.
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MNew Project ﬂ

— LCreate a Mew Source

Source File Type MNew Source. . |

1
Femowve |

Create a new source to add to the project [optional]. Only one new source can be specified now.
Additional new sources can be added after project creation wzing the "'Project->Mew Source"
command.

Exizting zources can be added on the next page.

Cancel Help

¢ Back

Click New Source.

Select VHDL Module and enter “decoder” as the file name:
Mewsource X

& IP [architecture Wizard)
@ Schematic:
@ State Diagram

3 File M ame:
Test Bench Y aveform e Hame
[2] Uzer Document IdECDdEI
Yerilog Module
Yerilag Test Fisture Locatiorn:
h VHDL Library IE:"-.E::EE?#"-.demder

WHOL Module
[¥] wHOL Package
5] WHOL Test Bench

¥ Add to project

¢ Back I Hest > I Caricel Help

Click Next.

—30f30-



Xilinx ISE and Spartan-3 Tutorial James Duckworth, Hauke Daempfling

You can now specify the inputs and outputs for the decoder. These will be inserted into an
automatically generated template for the VHDL file. We have one 3-bit input (“sel”’) and one 8-
bit output (“y”):

Define YHDL Source x|

Entity M ame Idecnder

Architecture Name IE ehavioral

Port Hame Direction M5B LSB
zel in 2 0
¥ out 7

LI

13

Click Next. You will be shown a summary window:

New Source Information x|

Project Mavigatar will create a new skeleton source with the
following specifications:

Saource Type: WHDL Madule ;I
Source Mame: decoder.vhd

Entity Mame: decoder

Architecture Mame: Behavioral

Part Definitions:

zel vector: 20 in
y vector Tl out

i o

Source Directory:  Checeb?4hdecoder

< Back Cancel | Help |

Click Finish.
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Mew Project ﬂ

— Create a Mew Source

Source File Type [ew Saurce. .. I
1 {decoder.vhd YHOL Module
Remaove |

Create a new source to add to the project [optional]. Only one new source can be specified now.
Additional new zources can be added after project creation uzing the "Project->Mew Source"
command.

Exizting zources can be added on the next page.

¢ Back Mest » Cancel Help

Click Next.

Mew Project ﬂ

—a&dd Existing Sources

5 Fil T C to Projec|
ource File ype SEIAS m|e-::ﬂ Add Su:uuru:e...l

Femove |

oo —
|

L [

Add existing sources to the project [optional]. Additional sources can be added after project creation
uzing the "Project-»Add Source or "Project-»Add Copy of Source commands.

¢ Back Cancel Help

We do not have any existing sources, so click Next.
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A summary window is show

Mew Project Information ﬂ

Project Navigator will create a new Project with the following specifications:

E'F"roiect:
Project Name: decoder
Praject Location: C:hece574hdecoder
Project Type: HOL
Device:
Device Family: Spartan3
Device: ¥c3s200
Package: ft256
Speed Grade: -4

Top-Level Module Type: HOL

Synthesiz Tool: ®5T WHDLA enlog)

Simulator: Modelzim

Generated Simulation Language: WHOL
Sources:

WHOL Module decoder. vhd

< Back I Finizh I Cancel Help

Click Finish.

Project Navigator now shows you a summary of the project:

A - Project Navigator ece574%decods | Summary] (=] ]
% Fle Edt Yiew Project Source Process Simdation  Window Help 2| 8|
T e e e | e R T e
2 =
Sources in Project | Design Dverview for decoder
B decoderise Property Value
E-£3 #e3s200-40255 Project Name Cecebiidecoder
[#) decoder behaviaral (decoder. vhd] I GRHDEES] 300
Flepon Generated, Monday 0341 3/05 a1 10:33
Frintable Summary [View as HTHL)| decoder summerhinl
Device Utiization Summary
Lagic Utilization
Diata Hot et Awailable)
Parformance Summary
Dats Mot Vet Available] |
Faling Constraints:
Constraint(s) Requested Actual[ Logic Levels|
~ Data Mot Vel Avaabl]
B Moduls Visw | 8 Snapshot | I1) Library Visw
Detailed Reports
21 Report Name] Status|Last Date Modified
Provesses for Source; "decoder behavioral”
f ting §
Create New Saurce
Yiew Design Summary
Design Usiiies
User Constraints
Create Timing Corstiaints
% Assian Packags Pins
BB Create frea Constraints
[#  Edit Constiaints (Tewt)
G Synthesize KT
5 Implement Design
% Generats Progiamming File
Pragramming File Generation Fepart
Generate PROM. ACE, or JTAG File
Configure Device [MPACT)
R Process View [ decodervhd 3 Design Sum...
x
Eunsu\eﬁﬁnd inFiies | 3€ Eors| T warings |
4
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Click on the “decoder.vhd” tab below the summary window, or double-click on “decoder-

behaviorial” in the top left “Sources” pane.

You will need to describe the behavior of the decoder using statements in the architecture body.
In this example we will use a conditional signal assignment statement:

I decoder.vhd * - | O] x|

Eile Edit Wiew

H 2 BRB|e = | il 7| # 4% %% 0%

=

20 library IEEE:

21 uze IEEE.S3TD LOGIC 1164.ALL:

22 use IEEE.STD_LOGIC ARITH.ALL;

23 use IEEE.3TD LOGIC UNW3IGNED.ALL:
24

22 end decoder;

54

25 architecture Behavioral of decoder is
fela]

37 hegin

E=t=]

=9 ¥ <= "00000001"™ when sel = "0OOO" eslse
40 "O0000010" when sel = "001" else
1} 1 "O00000100" when sel = "O10" el=e
42 "O00001000" when sel = "011" else
112 00010000 when sel = "100" el=se
144 "00100000" when sel = "101" else
k35 01000000 when sel = "110" el=e
=} ri0oooooarr;

47

e end Behavioral;

e

4 |

Ready

________________________________ =]

2 —— Cowpany:

3 -- Engineer:

4 —

5 -- Create Date: 10:33:48 09/19/05

=1 —— Design Naane:

7 —— Module Name: decoder - EBehavioral
2 —— Project Name:

= —— Target Device:

10 —-— Tool wversions:

11 —-- Description:

12—

12 —- Dependencies:

14 —=

15 —-—- Rewvision:

16 —-- Revision 0.01 - File Created

17 —— Additional Comments:

18 ——

18 o

25 ———-— Uncomment the following library declaration if
25 ———— ahy Xilinx® primitives in this code.

=7 —-library UNISIM:

22 ——uze UNISIM.VComponents.all:

28

=0 entity decoder is

=21 Port | sel : in std logic_vector (2 downto 0);
32 y o oout =td logic wvector (7 downto 0)):

instantiating

e

lnd6Colzl [ [uum v

Before we can synthesize this design we need to specify what pins on the FPGA the inputs and

outputs are connected to.
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ilink - Project Navigator - C:\ece574\decoder',decoder.ise - [decoder.vhd] =100
File Edit View Project Source Process Simulstion Window Help 3| (& x|
DleE@] 2| B2IE| BEEE [E L] (] o] ] =l 2l
NEDE| - Ek= P N e 2 Y Y B R
2=
Sowces in Project | g Revision: |
16 —- Revision 0.01 - File Created
j“ B decoderise 17 - idditional Comments:
B €3 %c3s200-40t256 o
[¥) decoder-behavioral [decader. vhd) Bl
20 library IEEE:
21 use IEEE.STD_LOGIC_1164.ALL:
22 use IEEE.STD_LOGIC_ARITH.ALL:
25 use IEEE.STD_LOGIC UNSIGNED.ALL:
2 - -
25 —- Uncomeent the following library declaration if instantiating
26 ———- any Xilink primitives in this code.
27  --library UNISIN;
25 --use UNISIM.VCOmponents,alls
za
30 envity decoder iz
51 Port ( sel : in std logic vector (2 downto 0):
= =2 v : out std logic vector (7 downto 0)):
5 Madule View [ i Snapshot .. | [ Library View i accouer; = =
;I5 34
55 architecture Behavioral of decoder is
Processes for Source: “decoderbehavioral' | e
-~ Add Existing Source 57 begin
B3 Create New Source e
X View Design Summary =0 ¥ <= "00000001" when sel = "000" else
&  Desion Utiities 20 "00000010" when sel = "0017" else
@@ User Constraints a1 000001007 when sel = "0107 else
ﬁ Lreats Timing Constraints laz "00001000" when sel = "011" else
/I -sian Package Pins 13 "00010000" when sel = "100" =lse
BB Create Area Constraints la "00100000" when sel = "101" else
[#  Edit Constraints (Text) a5 "01000000" when sel = "110" else
3 Synthesize - XST las 710000000 ;
-3 Implement Design la7
=63 Generats Programming Flle l458  end Behavioral:
-2 Programming File Generation Fiepart lag
Generate PROM, ACE, ar JTAG File =l
Configure Device (MPACT) »
B Process View E Design 5un_ [7] decoder.vhd
=
Conssle [ G Findin Files | 9€ Enors | @ ‘wamings |
Hierarchy is up to date, [tnag calz1 vHOL | ey

Double-Click on “Assign Package Pins” in the “Processes” pane in the left of the window.

Note: You may be asked to save the VHDL file, and your design will be checked for syntax
errors (these will need to be fixed before you can proceed).

The tools will prompt you to create a UCF file:

Xilink Project Navigator |

This process requires that an Implementation Constraint File (UCF) be added to the project and associated with the selected design module. Would you
\C/ like Project Navigator to automatically create a IUCF and add it to the project at this kime? IF you select "Mo" you will need to create or add an existing
UCF ko the project before running this process.,

Click Yes.
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The PACE editor will load:

ilink PACE - C:\ece574% decoder’,decoder.uck ;Iglil

File Edit Yew IOBs Areas Tools Window Help

[CFE& - n s gniesz giimame | [ Xaaxal// 0000 DEENE

B [=[E5) | il Device Architecture For xc3s200-4-ft256 =1ol x|
=4 140 Ping =
-1 Global Logic i—

E Logic
4 »

Design Dbject List - I;0 Pins o ] ]
1/0 Name| 1/0 Direction| Loc [Bank 170 Std = |
sel¢s Input
selcl> Input
selk2s Input
el Output
pel> Output
w2 Output
ped Output
P Output
W Output ==
b Output
w7y Mustrgt B

4 »
ﬂlEmup 1/0 Direction| Loc 170 Sid.
3 [sel Input
2y Output
lEl
| | 4 Package View b Architecture View / | I 4
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Select “Package View” at the bottom of the right pane (this simply gives a better view of the
physical FPGA package), and enter the pin names for each signal in the “Design Object List” at

the left as shown here:

HE wilink PACE - Cece574' decoder decoder.ucf

File Edit Wiew [0Bs Areas Tools Window Help

=10l x|

[DeH|E o |n L iz iieamel] xaaxap/[J0ROD0DEENR

RER RETE
Top View
12 3 4 85 B 7 8 9 10 11 12 13 14 15 16
A L] _ 00 0e] | LICTH ~
B N (L] @] B
: - c 9 JO0C c
iniL — pins B ank] I!D;IS—iIlI 2 . O ; : . 2
skl [Input 2 [BANK = [ | | 9@ E
an g o - |m ENEEEES O -
vl [Duput K2 [BANK G BEEEEEER® G
pls Output pld BAME
WD Dutput 2 BANK H [ BEEREEERENE o H
(T —— E— y EEEEEEER  m | .
[ S— T « A = = = = : = : e K
~ L L
_ M | | ] | M
#| Group|1/0 Direction|  Loc | 1705 | M [ ] O oHe M
|| P EN OO @005 P
R = — & R
7 [N B L NN
12 3 4 &5 B 7 8 9 10 11 12 13 14 15 16
4 | » | | LIt Package View £ Architechure View F Ll | » ;
A

Click File - Save followed by File = Exit.
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Note: The following dialog may appear when saving the file:

Bus Delimiter

x|

—Select 10 Bus Delimiter
{~ ®ST Default < »
% 35T Optional {}

= Synplify Yerilog Default: [ ]

= Synplifty WHDL  Exemplar Defaul: [

W Dan't show thiz dialog again

[zan be zet through preferences dialog)

]

Cancel |

Help

Select “Don’t show this dialog again” and click Ok.

Note: You may notice that the items listed in the “Processes” pane have changed. The
“Processes” pane shows the actions that can be run on the file that is currently selected in the
“Sources” pane. Select the “decoder-behavioral” source to get the same actions that were

previously shown.

You can then view the UCF file by double-clicking “Edit Constraints (Text)” in the Project

Navigator:
o -loix]
File Edit Yiew
H| rtERo e ErE(fThF 4% %% 0%
1 WPACE: Start of Constraints generated by FACE =]
z
2 HPACE: Start of PACE I/0 Pin Assignments
4 NET "sel<0=" LOC = "fiz"
5 NET "sel<ls" LOC = "glz®
(=] NET "sel<ix" LOC = "hig"™
T NET "wy<O=" LOC = "kilz"™
2 NET "w<l=" LOC = "pl4®
a NET "w<&z" LOC = "liz"
10 NET "w<3=" LOC = "nil4q"
11 NET "wy<d4=" LOC = "pl3r
12 MNET My<5>" LOC = "nilz®
13 NET "w<g>" LOC = Mplz®"
14 MNET "w<7=" LOC = "Mpll™"
15
16 HPACE: Start of PACE Area Constraints
17
18 #PACE: Start of PACE Prohikhit Constraints
19
Zz0 HPACE: End of Constraints generated by PACE
21
-
K| LI_I
Ready nicall [ M| 4

You are now ready to generate a PROM file and/or program the FPGA.
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Part 2: Generating a PROM File

In this part of the tutorial, we will see how to generate a PROM file that can be written to the
Platform Flash on the Spartan-3 board, so that your FPGA’s configuration is saved even when the
board is powered down.

If you do not want to generate a PROM file, you can skip directly to Part 3. However, in the
interest of this tutorial we recommend you complete this part as well.

We assume you are continuing from Part 1 above and are still in Project Navigator:

B xilink - Project Navigator - C:\ece574'decoder’decoder.ise - [decoder.vhd] =100
File Edit View Project Source Process Simulation Vindow Help 2| (& x]
D|E|@I@| | &Z|E| mH(H|E| [ Ll f(ole] o] s 19|
L = e O Y e e
2=
e ||| [ I — o
B decaderise

H 17 —- Ahdditional Comments:
£ #o3s200-41256 -

~[#) | decoder-behavioral {desoder. vhd)

20 library IEEE:

21 use IEEE.STD_LOGIC_1164.ALL:

22  use IEEE.STD_LOGIC_ARITH.ALL:
23  use IEEE.STD_LOGIC_UMSIGNED.ALL;

24

25  —-—- Unconment the following library declaration if instantizcing
P8 ——— any ¥ilinx primivives in this code.

27 —-library UNISIN:

28 —-use UNISIM.VComponents.all:

20

50 entity decoder is
el Fort ( sel : in std_logic vector (2 downto O) 2

L i ; :
B8 Module View | g8 Snapshor .| [ Library Yiew i y5i oUr Erd.logic vectbr!? downro 01

end decoder;

;Ix =4
— 35 architecture Behavioral of decoder is
Processes for Source: “decoderbehavioral” 1] ] 58
O AddExisting Source 57 begin
[ Create New Source EE]
-~ 3  View Design Summary 2o y <= "00000001" when sel =
B Design Utiities S| "00000010" when sel =
E-&F  UserConstraints 121 "00000100" when sel =
1z "00001000" when sel =
| g e Fins: 43 "00010000" when sel =
EE-‘ Create Arsa Constraints [ "00100000" when sel =
| Edit Constraints (Text) las "01000000" when sel =
B3 Synthesize - XST a8 "10000000";
3 Implement Design a7
B-¥3  Generate Programming File 42 end Behawioral:
B Programming File Generation Report lag
Generate PROM, ACE, or JTAG File =
Configure Devics [(MPACT) < o

" B Process View 3 Design Sum... V] decoder.vhd

=

" Bl Consale [T Find n Files | 3§ Enors | ¥ wamings |

Hierarchy is up to date.

Ln46 Col21 [vHOL | 4

Double-click on “Generate PROM, ACE, or JTAG File” in the “Processes” pane. You will
notice that Project Navigator will execute the steps listed above “Generate Programming File”
(Synthesis and Implement Design) and mark them with a green checkmark as they complete.

The iMPACT tool will open and a wizard to create a new configuration will open.
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Select PROM File:

Prepare Configuration Files

Click Next.
Enter the PROM File Name (for example, “decoder prom”):

Prepare PROM Files

checed 74 decodert

Click Next.
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Select the appropriate PROM (which is “xcf” / “xef02s” for this board) from the dropdown
menus and click Add:

Specify Xilink PROM Device

R R

PFosfon __ PanName

1} wcfl2s

Click Next.

You will be shown a summary:

File Generation Summary

Click Next.
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x
Drata Stream a

Starting Address [Max 8 Hex Digits) : ID
Mowe start adding device file(z] : Add File... |

Hewt > Cancel Help
Click Add File.
Laak ir: IE} decoder j - £ ER-
__projnaw

My A
[] (u]

_ngo
_xmsgs
xsk

. decoder, bit

File narne: Idec:n:-der.l:-it j Open I
j Cancel |

Filez of lype: I.-'i‘-.II Design Files

Select the “decoder.bit” file and click Open.
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You may get the following warning message:

%ilinx iMPACT x|

W ARNING:MPACT: 2257 - Startup Clock has been changed to 'Celk in the bitstream skored in memorsy,
but the ariginal bitskrean file remains unchanged.

Simply click Ok.

x4

:‘p Wiould vou like to add another design file ko
-

Data Skream: 07

Mo
Click No.
x
Data Stream : 0

Starting Address [Max 8 Hex Digitz] : IEI
Mow start adding device filefs] : AddlFile:.. |

Click Firush' to start generating file.

Click 'Cancel to go to uger screen.

< Back

Cancel Help

You can now click Finish.
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iIMPACT will ask:

PROM File Generation x|

:.i) Do o wank ko generate File now?

Select Yes.

You should then see iIMPACT report successful file generation:

=] c:ece574 decoder,/decoder.ipf [File Generation Mode] - iMPACT — |EI|1|
i

le Edit Wiew Mode Operations Outpub Help

EECEREELRE R EEE AL L
System ACE PROM Formatter | S‘JF—STAPL—XS‘JF'

EIXILINX
FROM

wofl2s
43 % Full

PROM File Generation Succeeded

#/ x%x BATCH CMD : addDewice —-position 1 —-file "C:ecebf?idecoder~decoder bit"
'1l': Loading file 'C:~ecebf?i~decoder~decoder bit'

INFO:iHFACT — Elapsed time = 0 =ec.

done.

INFO:iMPACT 501 — '1': Added Dewvice =c3=200 successiully.

H(E

GOl ——— Add one device.

<« x®%% BATCH CMD : setMode —pif
Collection : decoder prom
De=sign : 0

Dewvice Chain @ 0

Position PartHams FileHamns
=c3d=200 Ciweceb?4decoder~decoder  bit

</ *x%x BATCH CHMD . setAttribute —configdevice —attr fillValue —-wvalues "FF"

~/ *x%x BATCH CMD : setAttribute —configdevice —attr fileFormat —wvalus "mcs"

</ %% BATCH CMD : setAttribute —collection —attr dir —walues "UP"

</ %% BATCH CMD : setAttribute —configdevice —attr path —walue "o “ecebf?4decoder~"
~/ *x%x BATCH CMD : =etAttribute —collection —attr name —walue "decoder pron”

~/ *x%x BATCH CMD : generate

0x1f£f88 (130952) bytes loaded up from O=0

OT=zing user-specified prom =ize of 258K

Writing file
Writing file
Writing file
GUI ——— Total configuration bit =size = 1047616 bit=s.
G0l ——— Total configuration byte =ize = 130952 bytes.
<~ #%x BATCH CHD

Far Help, press Fi

"o wecet?ivdecoders sdecoder _prom.mcs" .
"o wecet?i~decoders decoder _prom. prmn” .
"o weces?i~decoders sdecoder _prom.sig".

zetCurrentDesign —version 0O

|File Generation Mode  [Prom Formatter |Serial Pram

&ILI
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Before you close iMPACT, select File > Save Project As...

Saveas 21|
Save jn; IE} decoder j = ¥ El-

__projnaw
_ngao
_¥msgs
wsk

by Documents

o B
-

File narne: Idec:n:-der_pr-:nm.ipﬂ j Save I
Save as hpe: IiMF'ﬁ'«I:T Project File[*.ipf] j Cancel |

Save the configuration under a filename such as “decoder prom.ipf”, but do not use the default
filename of “decoder.ipf” (if you follow Part 2a below, remember this filename).

You can now close iMPACT.
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Part 2a: Automatic PROM File Generation

Now that the configuration is saved, we can have Project Navigator automatically create the
PROM file without having to open iMPACT.

Warning: The settings we make in this part of the tutorial are global to the project. This means
that in larger projects where you have multiple bit streams, making these settings will likely

cause some confusion in generating the PROM file. In such projects you should not follow this
part of the tutorial and rather follow the steps in Part 2 every time you generate the PROM file.

However, for this class all your projects should be simple enough for you to be able to use this
method of automatic PROM file generation.

In the Project Navigator, right-click on “Generate PROM, ACE, or JTAG File” in the
“Processes” pane and select “Properties”.

In the Process Properties window that opens, set the “iMPACT Project File” to the

“decoder prom.ipf” file that you saved at the end of Part 2. This will cause iIMPACT to always
load this configuration. To enable automatic file generation (iIMPACT will not open, but the
PROM file simply created in batch mode), turn on “Automatically Generate File”.

Process Properties 5[

Generate PROM, ACE, or JTAG Properties |

Property Hame Value
iMPACT Praoject File zcaderhdecader_prom.ipf
Autamatically Generate File I~
System ACE CF Active Collection M ame

FProperty display level IStandard j

(] 4 I Cancel | Diefault | Help |

Click Ok to apply these settings.

Now, anytime you double-click “Generate PROM, ACE or JTAG File”, the PROM file will be
automatically created.
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Part 3: Programming the Board

In this part of the tutorial, we will show you how to actually program your design to the FPGA.
Make sure that your JTAG cable is plugged into your PC and the board, and that the board is
powered up.

We assume you are continuing from Part 1 or Part 2 above and are still in Project Navigator:

ilink - Praject Navigator - C:\ece574'decoder\decoder.ise - [decoder.vhd] =[O =]
File Edit View Project Source Process Simulation Vindow Help 2| (& x]

Dls(ElE 2| #2E BBEE[E e i o am 00 -] @
ke [ (=l v o] e e S Y Y |

<lx
Sources in Project JT i~ Revision: = |
16  —- Revision 0.01 - File Created
i@ decoderise 17 - Additional Comments:
£ £ sc3s20041256 e
[ decoderbehavioral [desoder. vhd) -

20 library IEEE:

21 use IEEE.STD_LOGIC_1164.ALL:

22  use IEEE.STD_LOGIC_ARITH.ALL:
23  use IEEE.STD_LOGIC_UMSIGNED.ALL;

24

25  —-—- Unconment the following library declaration if instantizcing
P8 ——— any ¥ilinx primivives in this code.

27 —-library UNISIN:

28 —-use UNISIM.VComponents.all:

20

30 entity decoder is

131 Port ( sel : in std_logic_vector (2 downto 0) 2

L i ; :
B8 Module View | g8 Snapshor .| [ Library Yiew i y5i oUr Erd.logic vectbr!? downro 01

end decoder;

;Ix =4
— 35 architecture Behavioral of decoder is
Processes for Source: “decoderbehavioral” 1] ] 58
#dd Existing Source 57 begin
Crsate New Source EE]
Wievr Design Summary el=] ¥ <= "00000001" when sel = "000" else
Design Utiities lio "00000010" when sel = "001" else
User Constraints b1 "00000100" when sel = "010" else
Timing Constraints 1z "00001000" when sel = "011" else
| 15 13 "00010000" when sel = "100" else
EE‘ Cieats Area Constraints (4 "00100000" when sel = "101" else
[ Edi Constraints (Tew) lis "01000000" when sel = "110" else
B3 Synthesize - %X5T las "10000000":
3 Implement Design a7
B-¥3  Generate Programming File 42 end Behawioral:
B Programming File Generation Report lag

g Generate PROM, ACE, or ITAG File =i

Configue Device (MPACT) 4 LI_
a B Process View l— 3 Design Sum... [] decoder.vhd

=

" Bl Consale [T Find n Files | 3§ Enors | ¥ wamings |

Hierarchy is up to date. Ln46 Col21 [vHOL | 4
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Note that this following step of changing the Start-Up Clock is not absolutely necessary because
iIMPACT will automatically pick the correct clock, but doing the following avoids a warning
message telling you about this every time you program the board.

Right-click on “Generate Programming File” in the “Processes” pane and select “Properties”.
In the “Process Properties” window that opens, select the “Startup Options” tab.

Change the “FPGA Start-Up Clock” to “JTAG Clock”.

x
General Options I Configuration Optionz  Startup Options | Readback Options I
Property Hame Yalue
FPGA Start-Up Clock -
Enable [ntemal Done Pipe I
Dione [Dutput Events] Drefault [4]
Enable Outputs [Dutput Events] Default [5]
Releaze ‘Write Enable [Output Eventsz) Default [B]
Releaze DLL [Output Events] Drefault [Mais ait]
tatch Cocle Ao
Dirive Done Pin High [
Property display lewvel IStandard j
] I Cancel | Default | Help |

Click Ok.
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Double-click on “Configure Device (iMPACT)”. The iMPACT tool will open and a wizard to
create a new configuration will open.

Configure Devices

Click Next.

Boundary-Scan Mode Selection

Click Next.
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The following window will briefly show:

Cable Motification

4 ! Connecting to dawnload cable...

I

IMPACT will inform you that it has found the devices on the board:

Boundary-Scan Chain Contents Summary x|

i There were 2 devices detecked in the boundary-scan chain.
\J) iMPACT will now direct you ko associake a programming or
BSOL File with each device, starking with the First. ..

You can now select the configuration files that will be programmed to the parts.

Strange Software Bug Warning: Sometimes — specifically, if the top portion of the main iMPACT
window is not large enough to display the diagram of the two parts — the following file selection
dialogs will not pop up automatically. If this happens, you will need to right-click on each of the
two parts (the FPGA and the PROM) and select “Assign New Configuration File...” when
following the next steps:

—23 0of 30 —



Xilinx ISE and Spartan-3 Tutorial James Duckworth, Hauke Daempfling

First, the FPGA should be highlighted in the main window (“xc3s200”). You should select the
“decoder.bit” file:

Laak jn: IE} decoder j = £F Ed-

File name: Iu:leu:u:u:ler.l:-it j Open I
j Cancel |

Cancel Al I Bypazs |

Files of ype: I.-’-'-.II Dezign Files

Click Open.
If you did not previously change the “Start-Up Clock”, you may receive this warning:

ilinx iMPACT x|

W AR NING:MPACT: 2257 - Startup Clock has been changed to 'JtagClk in the bitstream skored in memaorsy,
but the ariginal bitskrean file remains unchanged.

Simply click Ok.
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The PROM should now be highlighted in the main window (“xcf02s”). If you followed the steps

in Part 2, select the “decoder_prom.bit” file that you generated. If you skipped Part 2, click
“Bypass” instead of Open.

Lk ir; IE} decoder j 4= ¥ B3~

__projnay
_hgo

_xmsgs
sk
decoder_prorm.mcs

File narme; Ideu:u:uder_prnm.mu:s j Open

i

Files of twpe: IMES Files" mez] j Cancel

| Cancel Al I Bypazs |

Click Open, or Bypass if you did not complete Part 2.
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You will now be at the main iMPACT window:

[=] chece574%decoder/decoder.ipf [Configuration Mode] - iIMPACT

File Edit Yiew Mode Operations ©utput Debug Help

—loix]

Ded ey agHEEE20s SR
Boundary-5Scan | Slave Serial I SelectMAF'l Desktop Configuration |

Wersior: ()
UserCode: not et read
Security: not secured

Chksum: not applicable
DI E Program: unknown

35200 #ofl2s
decoder. bit decoder_prom.mecs

TDC

=xaflls_woZ0
wafl2= wolZl
xafld=s_woZl
xclB8wll_pc20
=clB8w0l_=o20
=clBw0l wgdd
=clBvi2_podd
=clBvwi2_wgdd
=xcl1B8w04_pcdd
wclB8w0d_wgdd
xcflls woZl
xcfl2= woZl
zcflds wol20
=cf08p f=48
=cf08p_wo4s
=zcflep f=48
=xcfl6p_wodB
ucf3Zp f=48
xcf3Zp wodd
<« wxxx BATCH CHD : sethittribute —-position 2 -attr devicePartHame -valus "zcflZs"

'2': Loading file 'C:~ecef?4idecoder~decoder prom.mcs'
done.

Device #1 selected

Device #2 selected

Device #1 selected

0l

s wxx BATCH CHD : setittribute —-position 2 —attr configFileName -value "C.ecebf?4~decoder~decoder p

il

Far Help, press F1 |Cnnfiguratinn Mode ‘Bnundary-ﬁcan |Para\|e| huns

200 KHz v

Right-click on the FPGA (“xc3s5200”) and select “Program”. The following dialog will appear:

I¥| Erase Before Frogramming [T Functional Tiest

[~ Werily ™| En:The-Fly Frogram
" Bead Frotect
[~ wirite Frotect

= Wirkes-1|

= Pulse FROG
™ Secue Mode
™| Frogram key

PROM

T Load FRG#
™ Earalel biode
[/ Wze D4 for CF

™| PR/ ConlFunner-l| Usercade (8 Hiex Digite]
| FFFFFFFF

I | =<PLA UES: Enter up to

13 characters

Ok, Cancel | Help |

Make sure that “Verify” is not checked and click Ok.
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The FPGA will now be programmed:

Operation Status

E #ecuting command...

Followed by the message:

ece574'decoder/decoder.ipf [Configuration Mode] - iMPACT

File Edit Yiew Mode Operations Output Debug Help

o [=]

BRI E I L
Boundary-Scan |Slave Seriall ScledMAPl Desktop Cunfiguratiunl

|

TDI | Eoans

wodz200 wof02s
decader bit decader_prom.mos

) Programiming Succeeded

'1' Programnmning device. ..

done.

'l': REeading status register contents. ..
CRC error

RESERVED

DCH locked

DCI Matched

legacy input error

status of GTS CFG B

status of GUE

status of GHIGH

value of MODE pin MO

value of MODE pin M1

valus of MODE pin M2

valuse of CFG_EDY (INIT_B)

DONEIH input from DOHE pin

ID_EREOR

RESERVED

EESERVED

INFO:1iHPACT: 2219 — Status register walues:
INFO:iMPACT — 0011 0111 0001 1000 0000 0000 0000 0000
INFO:iMPACT:579 - '1': Completed downloading bit file to device.
INFCO:iHMPACT:580 - '1':Checking done pin ... .done.
'l': Programmed successfully.

PROGEESS EWND — End Operation.

Elapsed time = 5 sec.

4

OoOOoORHROOOHRHRRORRHEOOD

ol

Faor Help, press F1 |C0nFigurati0n Made |Boundary—5can

[Parallel 1T [Ipt1

[e00 KHz2 Y
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If did not follow the steps in Part 2, you can skip the following steps for programming the
PROM.

=] chece574decoder /decoder.ipf [Configuration Mode] - iMPACT ) m| il
Ele Edit Wew Mode Operations o©utput Debug Help

IDEH| &Ry 2R mEdEEE o5
Boundary-Scan |Slave Seriall SeleclMAF'l Desktop Cunfiguraliunl

Wersion: 0
UserCode: not yet read
Security: not secured

Chk.sum: not yet cale
oI gSKIL\NKE DZ Program: unknown

wc3s200 wofll2s
decoder.bit decoder_pram.mes

TDO

done B

'1': Reading status register contents. ..
CRC error

]
RESERVED 1]
DCH locked 1
DCI Matched 1
legacy input error o
status of GTS_CFG_B 1
status of GWE 1
status of GHIGH 1
walue of MODE pin MO 1]
walue of MODE pin M1 1]
walue of HODE pin M2 1]
walue of CFG_RDY (INIT B) 1
DONEIN input from DONE pin 1
ID_ERROR 1]
RESERVED 0
RESERVED 0
INFO:iMPACT: 2219 - Status register values:
INFO:iMPACT — 0011 0111 0001 1000 0000 0000 0000 0000
INFO:iHPACT:579 — '1': Completed downloading bit file to device.
INFO:iMPACT: 580 — '1':Checking done pin ... .done.
'1': Programmed successfully
FPROGRESS_END — End Operation.
Elapsed time = E =ec.
Device #2 selected =
4 | »
For Help, press F1 |Configuration Mode  [Boundary-Scan |Parallel I [Ipt1 |z00 KHz A

Right-click on the PROM and select “Program”. The following dialog will appear:

I Eraze Before Programming [ Functional Test

v erify ™| On-TheFly Bragram
[~ Bead Protect
[ swdrite Protect

— Wirkex-l|

I~ Pulse FROG
[T Secure Mode
™| Frogram key

PROM
™ Load FPGA

[T | Baralleliiode
™| Use 04 for CF

[~ PROM/CoolRunnerll Usercode [8 Hexs Digits)
| FFFFFFFF

[~ =Pl ES: Enter up to 13 characters

Cancel | Help |

Make sure that “Erase Before Programming” and “Verify” are both checked. Then click Ok.
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The device will be programmed:

Operation Status

E #ecuting command...

O

Followed by the message:

=] ce574'decoder/decoder.ipf [Configuration Mode] - iMPACT - |El|i|

File Edit Wiew Mode Operations Oukput Debug Help

JDD"H| dBRRE B NDEHESSO|E| SN
Boundary-Scan |Slave Seriall SelectMAPl Desktop Cunfiguratiunl

TDI ForlLing
wcdz200 wofl2s
decoder. bit decoder_prom.mcs . .
e Programming Succeeded
'1l': Programmed successfully. ‘:J
FROGEESS_EWD — End Operation.
Elapszed time = L =ec.

Device #2 =selected

Device #2 =selected

< %%x% BATCH CHD : Program -p 2 —e —-v
FROGEESS_START — Starting Operation.
Validating chain. ..

Boundary-scan chain wvalidated successfully.
'2': Erasing device. ..

Erasure completed successfully.

done .

'2': Putting device in ISF mode. . . done.
'2': Putting dewvice in ISE mode. .  done.

'2' Verifying device.. done.

'2': Verification completed successfully.
'2': Calculated checksum matches expected checksum, 001fiec?3f
'2': Putting dewvice in ISF mode. . . done.

'2': Putting device in ISF mode. . . done.

'2': Setting user—programmable bits. ..

'2': Putting dewvice in ISF mode. . . .done.
'2' . Programming conpleted successfully.
Programming completed succes=sfully.
FROGREESS EWND — End Operation.

Elapsed tims = 27 =ec. -
4| | i3

For Help, press F1 |Configuration Mode  [Boundary-Scan |Parallel 111 [Ipt1 200 KHz 4
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You can now close iIMPACT. You may be asked:

Save Project File x|

\?r) Save changes ko project file cieces74decader/decader ipf?

Mo | Cancel |

If you followed the steps in Part 2a above, you can select Yes here, otherwise make sure to
always answer No.

If you did not follow the steps in Part 2a, and accidentally click Yes in this dialog, then whenever
you double-click “Generate PROM, ACE, or JTAG File”, iIMPACT will not show you the dialogs
to create the PROM file as shown in Part 2. There are two workarounds to this problem: (1)
delete any “*.ipf” files in the project’s directory before you try to generate a PROM file, or (2)
when iMPACT opens, select File > New and select “Prepare Configuration Files”, then follow
the steps as described in Part 2.
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